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OPERATING SYSTEM

5.1 INTRODUCTION

Most well accepted operating system used by the computer users
world wide was Disk Operating System or DOS. Over the years, lots
of features were added to DOS, which was initially introduced to be
used with PC with Intel’s 8088 chip set. However, recent introduc-
tion of Windows operating system with Graphical User Interface build
into it, a computer user need not remember all the operating sys-
tem commands by heart. This has been possible with the introduc-
tion of windows Operating system by Microsoft, which provides ma-
jor improvements such as graphical operating environment, net-
working of computers, in build multimedia capabilities and perform-
ance enhancement to DOS.

Most of the personal computers you see today comes with Microsoft
Windows operating system. It is an operating system meant for IBM
compatible PCs. Operating system is the software that makes it
possible for you to work on your computer and have it perform the
tasks you need. Windows98 is an updated version of Window95.

5.2 OBJECTIVES

After going through this lesson, you would be in a position to

l explain various features of Windows98
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l explain various icons and their features

l define file management features of Windows98

5.3 MAIN FEATURES OF WINDOWS98

The following are the main features of Windows98 operating system.

— Creates the link between the user, and the computer by providing
an interface in which the user can communicate with the
computer

— Serves as the base software on which a variety of programs can
operate. Examples include MS Word, MS Excel, MS Power Point,
and MS Access

— Handles internal functions, such as managing the computer
memory, input and output operations

— Provides a series of utilities - specialized programs to manage
your system - and commands that you can use to manage your
files, folders, and disks

— A Graphical User Interface (GUI), which uses pictures, symbols,
windows, and words on your screen that you control with the
mouse

— Built-in programs, or accessoires like, WordPad, Notepad,
Calculator, Paint program etc.

— The ability to display several documents and run a number of
programs in their own windows, all at the same time.

— The World Wide Web (WWW) is easily accessible from anywhere
in windows. You can communicate over the Internet. Using
Internet tools included with windows, you can send e-mail, chat,
and view news.

— Supports DVD and digital audio, so that you can play high
quality digital movies and audio on your computer. You can
also watch TV.

5.3.1 Using the Mouse

Windows98 is designed for use with a mouse. Although, you can
use the keyboard for most actions in Windows 98, many of these
actions are easier to do with a mouse. You will use four basic mouse
actions throughout this course.
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1. Pointing: Moving the mouse to place the pointer on an item is
called pointing.

2. Clicking: Pointing to an item on your screen and then quickly
pressing and releasing the left or right mouse button is called
clicking. You select items on the screen by clicking. Occasionally
there are operations you perform by clicking the  right mouse
button, but unless you are instructed click the left mouse button.

3. Double-clicking: Pointing to an item and then quickly pressing
and releasing the mouse button twice is called double-clicking.?
Whenever you are unsure of the command to use for an
operation, try clicking the item you want to affect. If you get no
result, try double-clicking. This often displays a dialog box in
which you can make changes to the item you double-clicked.

4. Dragging: Pointing to an item and then holding down the mouse
button as you move the mouse is called dragging. You can use
this action to select data, and to move or copy text or objects.

5.4 SYMBOL FOR MENU COMMANDS

As a shortcut, we have used a special convention to indicate menu
commands throughout this course. When you want to choose a
command from the menu bar, it will follow this pattern: menu name
command. For example, “Choose File Open” is a shorter way of saying
“Choose the File command from the menu bar, then choose the
Open command from the File menu”. Sometimes you will see a
sequence of menu selections that goes three or more levels.

5.4.1 Desktop

When you turn on your computer, the screen first displays Basic
Input Output Information about your computer. Few seconds later,
Windows takes control and the Windows logo flashes on your screen
with the cloudy sky. You could see “Microsoft Windows98”. The first
thing that always appears after loading is that you will be asked to
type your passward to enter Windows (it is the password you typed
the first time Windows was launched). The Desktop is where you
might place useful things always accessible to you. Depending on
which options you choose during installations, you will see some or
all the objects in Figure 5.1
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Fig. 5.1: The Windows Desktop

5.4.2 Desktop Icons

1. My Computer: My Computer is the most important Desktop
item (see fig. 5.1). This is where everything is present: your
hard drive, floppy, CDROM, computer’s main control (Control
Panel). All the computer resources can be accessed from My
Computer - it is the gateway to your computer. To access My
Computer, double-click on its icon in the Desktop.

My computer contains:

(i) Hard Drive (s) (C: D:)

(ii) 3.5 Floppy Drive (A: )

CD_ROM Drive (E: )

(i) Printers

(ii) Control Panel

(iii) Dail-up Networking (used especially for Internet
Connection)

(iv) Scheduled Tasks (give your computer jobs to perform when
you are out)

My Computer window (see fig. 5.2) looks just like any window you
open, you can minimize, this Window with  -, maximum with and
close by clicking on x.

In My Computer you are forbidden to Delete, Copy, Rename anything,
try to press delete key and nothing will happen. The items in My
Computer window are so crucial that you cannot run your computer
without them. For example, if you remove the hard drive where would
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you store your files. Since, My Computer items are related to the
computer system they should remain intact.

Fig. 5.2: My Computer

Suppose you want to use My Computer to view your hard disk. On
the Desktop double-click My Computer. The My Computer window
(see Figure 5.2) with different icons will appear.

Double-click the icon (see fig. 5.2) that represents your hard disk.
Your hard disk window appears, and the contents of your hard disk.

Similarly you can double-click the other icons in My
Computer.

To view the contents of the floppy disk, which is usually
designated drive A:

To view the contents of the hard disk, which is usually
designated drive C:

To view the contents of the hard disk, which is usually
designated drive D:

To view the contents of compact disk in the CD-ROM
drive designated as E:

To set up printer and view information about available
printers and print job status.

To view tools you can use to modify your computer
settings.

To schedule or view tasks for computer maintenance
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To view web folder contents

To view shared information on another computer by
using a modem.

5.4.3 The Properties Window in My Computer

To learn more about each item, just choose one icon, right-click and
select Properties from menu. The Properties window is divided into
four tabs: General, Tools, Sharing and Compression. If you select
the Floppy icon, the General tab shows information about your floppy,
storage device. It tells you how much space you still have on your
disc, and the total size in KB or MB. You should have a total of
1.45,664KB if you’re using a 1.44 MB floppy. At the top of the window
is the floppy lable, usually it is blank. The pie chart shows clearly
the Used Space and Free Space (see Figure 5.3)

Fig. 5.3: The Properties Window

The Tools tab in fig. 5.3 features the following three important
Windows utilities:

Error-checking status: It is a  utility that let you check your computer
for errors. If you accidentally turned your computer off without
properly shutting down, it will run when you restart your computer
and perform a scan on your hard drive.

Backup status: This utility lets you backup important stuff so you
will never lose anything in case your computer was damaged. You
should always keep two copies of your work you store in computer.
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Defragmentation status: Use this utility to make your computer
run faster. The more you use the computer the more “it gets tired
and old”. Defragmentation will refresh it.

The Sharing tab will tell you whether your hard disk is shared by
other network users or not.

The Compression tab is almost never used. Suppose one day you
run out of disk space, you can use the Compression utility to squeeze
your files and generate more room.

Beside My Computer there are quite a few icon on the Desktop.
These are as follows:

1. My Documents: This is where you store all your personal stuff
like files, anything you create with your computer. You can put
your things somewhere else also. Think of My Documents as
your Desktop drawer where you can put your papers.

2. Recycle Bin: Provides space for deleted files from folders or
Desktop, and provides a second chance to recover files deleted.

3. Internet Explorer: It is a piece of software called a browser that
lets you explore the Internet. You might have another icon like
“Internet Connection” that will help you configure your computer
to access the Internet.

4. Network Neighborhood: Provides access to shared resources
on your computer and other computers on your local and wide
area networks. If your computer is connected to a network, you
can use Network Neighborhood to browse network resources in
the same way you browse the contents of your computer.

To open network resources follow the steps given below:

i. On the Desktop, double-click Network Neighborhood. The
computers in your workgoup will appear. If you want to
view all of the resources available on the network, double-
click Entire Network.

ii. Double-click the servers and folders you want to open.

5. Online Services: As online services is a subscription computer
service you can see it to access a wide variety of information
and exchange messages with other users. With online services,
you can obtain information on news, sports, weather, the stocks



Operating System  :: 101

market, and more. You can get access to different libraries and
databases. You can send mail to other users of the online service.
Examples of online services include America Online,
CompuServe, Prodigy, and MSN.

6. Date, Time, Volume: At the bottom right corner of the screen,
you can tell what time is it. By clicking your mouse over the
clock icon, you’ll get the date. You can also control the sound
by clicking on the speaker icon.

7. Start Button: This button lies at the bottom left of your screen.
It provides an easy way to start different programs and other
applications.

8. Taskbar: This lies at the bottom of your screen. This displays
all open applications and windows. The Start button and the
Taskbar work together and help you in managing your
applications open or close windows easier.

You will learn more about these Desktop icons in the next few
sections of this lesson.

INTEXT QUESTIONS

1. Write any five main features of Windows98.

2. Explain the following terms used in application of mouse: (a)
Pointing, (b) Clicking, (c) Double-clicking, (d) dragging

3. What is Desktop? What are the main items you see on a
Desktop?

4. What are the main components of My Computer?

5.5 START BUTTON AND TASKBAR

At the bottom left corner is the Start button. Place the mouse over
Start and you will see “click here to begin”. Start gives you access to
all applications on your computer, every time you install a software
on your system, you can easily have access through the Start button.
Click on Start and the Start menu appears. Figure 4.4 shows the
main menu items available when you click on the Start button.
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Fig. 5.4

5.5.1 Programs Submenu

Every program on your computer can be accessed from Programs
submenu, you can also access the Computer Accessories like System
Tools, Communication and Entertainment features. Move your mouse
pointer over the programs items on the Start menu, and another
menu will pop up. In fig 4.5 we clicked on programs and then on
accessories. In the next column we clicked on games and then on
Hearts.

Fig. 5.5: Programs Submenus

When you open programs and files on top of other programs and
files on the Desktop, Windows 98 keeps track of all your open
windows and lists them on the Taskbar. The advantage of the Taskbar
is that when you have multiple applications open at the same time,
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you can see all of them listed in the foreground, whether or not they
are hidden by another windows. Even if an application window is
minimized on the Desktop, it can still be accessed from the Taskbar.
By clicking on the applications window on the Taskbar, you can
bring that application to the front of other windows, and restore if it
was minimized. The more windows you open, the more items will be
listed on the Taskbar. You can increase the height of the Taskbar,
place the mouse pointer over its top border, the pointer will turn
into double-headed sizing arrow (). Then, click and hold your left
mouse button and drag up.

5.5.2 Favorites Submenu

While surfing the internet you can store your favorite addresses in
this folder so that you don’t have to memorize them. This feature is
very useful for Internet users. You can also quickly get to documents
or folders or to other computers on your network.

5.5.3 Documents Submenu

Windows keeps track of recent documents used. The Documents
option of the Start menu makes available the last 15 documents you
had opened in any application. Click on Documents in fig. 4.4 and
you will see a list of documents you have been working on recently.
The documents are listed alphabetically, not by use, and will be
listed whether you open them from within an application or from
the folder where they are stored. If you find these doucments
irrelvant and don’t want to access, you can clear the list: Right click
on the Taskbar. In a small Window you will find ‘properties’. On
Clicking there, another Window will open up. Click on the ‘Start
Menu Programs’. There at the documents menu, click on the ‘Clear’
button.

5.5.4 Settings

From here you have access to the Control Panel (see Figure 4.5
Printers, Taskbar and Start menu, Folder Options, Active Desktop,
and Windows update. You can add/delete programs, change monitor
settings, connect to networks, create a Startup Disk, Customize
Desktop display properties, and set up Dialup Networking. The main
features of Control Panel are:

1. You can do most of your customizing of your Windows
environment., You can display pictures, patterns, or even
scanned photographs as your wallpaper, the background of your
Desktop. Using the different tabs in the Display Properties dialog
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box, you can also change items such as the icons on your
Desktop, the colors of individual windows, and the size of the
objects on your screen. You can even add items to your Active
Desktop or set up a screen saver.

2. You can quickly install Programs, such as MS Word or a game,
using the Add/Remove Programs features in Control Panel.

3. You can also connect your computer to a network using Network
features in Control Panel. To connect your computer to a network
follow the steps given below:

i. Click Start, select Settings →Control Panel, and then
double-click Network dialog box appears. Click Add. Select
Network Network. Component Type dialog box appears.
Click Client, and then click Add. A list of client software
appears.

ii. In the Manufactures list, click the name of the manufacture
of your network software.

iii. In the Network Clients list, select the client software you
are using, and then click OK. The client software is added
to your computer.

iv. On the Configuration tab, select your client, and then click
Properties. Enter configuration options for your network,
and then click OK. (If you don’t know the options for your
network, contact your network administrator).

v. Click OK and then click OK again. The client software is
installed and your computer restarts.

4. If you have problems with Setup or have trouble in starting
Windows98, you can use a Startup Disk to start your computer
and run Setup or gain access to your system files. If you have
problems with your hard disk, for example, you can use a Startup
Disk to start your computer and troubleshoot your hard disk.

To create a Startup Disk from within Windows98 follow the steps
given below:

i. Click Start, point to Setting, click Control Panel, and then
double-click Add/Remove Programs. The Add/Remove
Programs Properties dialog box appears.

ii. Click the Startup Disk, tab, and then click Create Disk.
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iii. Label a floppy disk “Windows 98 Startup Disk” insert it into
your floppy disk drive, and then click OK.

To start your computer using Startup Disk follow the steps given
below:

i. Insert the Startup Disk in the floppy disk drive.

ii. Restart your computer. The Windows 98 Startup menu
appears. Type the number of hte appropriate CD-ROM
option, and press ENTER. Follow instructions on your
screen. After a series of scans, the MS-DOS prompt appears.
From this prompt, you can gain access to the system files
on the Startup Disk.

5. You can Add Printer wizard to quickly set up printers, select
default printers, and change printer settings. The wizard guides
you step-by-step through printer set up.

5.5.5 Find

When you are looking for a particular folder or file, you can use the
Find command instead of opening numerous folders. The Find
command lets you quickly search a specific drive or your entire
computer or a computer on your network.

5.5.6 Help

When you are stuck, Windows can give you a hand, just go to START
HELP or press F1 on your Keyboard.

5.5.7 Run

This is the fastest way to start a program or install software on your
computer or start programs or open folders or connect to network
resources. With Run you will have instant access to everything.
However, the Run option is for more experienced user. Selecting
Run brings up the RUN window where you can type the name of a
file or folder that you wish to open. If you don’t know the entire path
of folders within which a specific file or folder can be found, you can
click on the Browse button within this window to find what your are
looking for. Athough, this is generally not the quickest way to open
a document or run a program, sometimes it simply seems more
direct than opening a sequence of folders to get the one you need.

5.5.8 Shut Down

You should Shut Down Windows at the end of a session never turn
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the power off close all applications and click START, select Shut
Down and press OK. Many new computers automatically turn the
power off once you have Shut Down. In case your computer do not
have this feature turn the power off.

5.5.9 Log Off

This feature is used only when you share your computer with others.
If you are the only one using the computer you need not choose this
feature.

5.6 WINDOWS EXPLORER

Windows Explorer is a feature that you can use to view the contents
of your computer and network drives in a hierarchical structure.
Instead of opening drives and folders in separate windows, you can
browse through them in a single window. The left side of the Windows
Explorer window contains a list of your drives and folders, and the
right side displays the contents of a selected folder. To use Windows
Explorer, click on Start button and then click Programs Windows
Explorer.

Fig. 5.6: Explorer Window

Windows Explorer has the following features:

l You can copy a file or folder containing a number of files from
one folder to another folder or one drive to another drive by
simply placing the cursor on the source file or folder and dragging
it to the destination folder or drive. You can also do this using
Copy and Paste.
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l You can delete a file or folder by selecting the file or folder and
then clicking on the Delete on the Toolbar. Windows will send
it to the Recycle Bin.

l You can move a file or folder form one folder or drive to another
folder or drive using Cut and Paste.

l By mistake if you have deleted, or moved or copied a file or
folder and want the file or folder in its original place, you can
do it pointing the cursor on Undo and then clicking.

l You can open a file its program by double clicking a file.

5.7 MANAGING FILES, FOLDER AND WINDOWS

To use Windows, you need to know two things: files and folders. The
following first three icons represents different folders and the next
three icons represent different types of files.

Fig. 5.7

Files always lies in folders. In Windows98, you can organize your
documents and programs to suite your preferences. You can store
these files in folders, and you can move, copy, rename, and even
search for files and folders.
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File names in Windows 98 can be up to 255 characters, including
spaces. However, file name cannot contain any of the following
characters: \ / : ? < > |.

5.7.1 Creating Folders

When you use a program and save your work, or when you install a
program, you are creating files. You can store files in many location
- on the hard disk, a network drive, a floppy disk, and so on. To
better organize files, you can also store them in folders.

To create a folder follow the steps given below:

1. On the Desktop, double-click My Computer. My Computer
Window opens.

2. Double-click disk drive or folder in which you want to create a
folder. The drive or folder window opens.

3. On the File menu, point to New, and the click Folder. Type a
folder name, and the on press ENTER. The new folder appears
in the location you selected.

To find a file or folder follow the steps given below:

1. Click the Start button, point to Find, and then click Files or
Folders. The Find dialog box appears.

2. Type the file or folder name you want to find. Click the Look in
down arrow, or click Browse to specify where to search. Click
Find Now. After a moment, the results of the search appear.

To open a file or folder follow the steps given below:

1. On the Desktop, double-click My Computer. The My Computer
window opens. Otherwise, you click on Start and Choose
Programs Windows Explorer.

2. Double click the drive that contains the file or folder you want
to open.

3. Double click the file or folder you want to open.

To rename a file or folder follow the steps given below:

1. On the Desktop, double-click My Computer. The My Computer
window opens. Otherwise, you can click on Start and choose
Programs→Windows Explorer.
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2. Double click the drive that contains the file or folder you want
to rename. Select the file or folder you want to rename.

3. On the File menu, click Rename. Type a name, and then press
ENTER.

To copy or move a file or folder from one location to another location
follow the steps given below:

1. On the Desktop, double-click My Computer. The My Computer
window opens. Or click on Start and Choose Programs Windows
Explorer.

2. Double click the drive that contains the file or folder you want
to move. Select the file or folder you want to copy or move.

3. On the Edit menu, click Copy to copy the file, or click Cut to
move the file. Double-click the folder in which you want to place
the file or folder. On the Edit menu, click Paste. The file appears
in its new location.

To delete a file or folder follow the steps given below:

1. On the Desktop, double-click My Computer. The My Computer
window opens. Or click on Start and Choose Programs→

Windows Explorer.

2. Double click the drive that contains the file or folder you want
to delete. Select the file or folder you want to delete.

3. On the File menu, click Delete. The ‘Confirm File Delete’ dialog
box appears. Click Yes. The file is moved to the Recycle Bin.

To permanently delete a file or folder follow the steps given below:

1. On the Desktop, double-click Recycle Bin. The Recycle Bin
window opens. Select the file or folder you want to permanently
delete.

2. On the Toolbar click on Delete. The Confirm File Delete dialog
box appears. Click Yes. The file is permanently deleted. (If you
want all files and folders in Recycle Bin are to be deleted, then
on the File menu, click Empty Recycle Bin. The Confirm File
Delete dialog box appears. Click Yes. The file is deleted from to
the Recycle Bin.)

5.7.2 Shortcuts

For an easy access to a file that you use frequently, you can create a
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shortcut to it. A shortcut does not change the location of a file - the
shortcut is just a pointer that lets you open the file quickly. If you
delete a shortcut, the original file is not deleted. There are a number
of ways to create a shortcut to a file. The most direct approach is to:

1. On the Desktop, double-click My Computer. The My Computer
window opens. Or Click on Start and Choose Programs →

Windows Explorer.

2. Double click the drive that contains the file or folder you want
to create a shortcut.

3. Select the file or folder you want to create shortcut. Right-click
on the file or folder. On the menu that appears, click Create

Shortcut. The shortcut appears on the selected drive or folder.
(If you want to place the shortcut on the Desktop right-click on
the file or folder. On the menu that appears, click Send To →

Desktop (create shortcut). The shortcut appears on the Desktop.)

To remove a shortcut from your Desktop, drag the shortcut to the
Recycle Bin icon or use the right mouse button pointing the shortcut
to be delected and click Delete. To rename a shortcut, close all other
open windows, click the right mouse button pointing a file or folder
icon to be renamed, click Rename on the menubar that appears.
Type  the new name to replace old name and then press ENTER.

5.7.3 Windows Most Common Tasks

Every Folder in Windows has a layout as shown in Figure 4.6. This
layout is called a window. The Menu Bar, Title Bar, Taskbar, Scroll
Box, and three squares- x) at top right are common to all windows,
whether you have a Folder or File - Open or Close. To start an
application or access a file/folder you have to Open, when you finish
you should Close. You have already learned about Taskbar. We will
discuss the other parts of window now.

1. Minimize, Maximize/Restore, and Close

Every window has 3 squares at the top right of screen - x. The
minus sign is Minimize. A minimized window is still open, and
a window button appears on the Taskbar. The double-square is
Maximize/Restore. You can maximize the window of your file
to fit the entire screen. It you click again the application takes
the usual size (you can see the Desktop behind) If you have
several files opened, “maximizing” put them on top of each other
so you can see only one file at the top, by “restoring” you will
have all the files visible on the desktop, just choose one and
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start working: you can write and draw at the same time very
easily. To close anything just press on x.

2. Title Bar

The Title bar resides at the top of the screen. It displays the
name of the program in which you are working. It also displays
the name of the file or folder or drive you are working with. You
can also use Title bar for enlarging and reducing the window by
double-clicking on the Title bar. Suppose you opened two or
more windows (file, folder), to see in which one you are working,
look at the Title bar and the title bare shows the active window.
The advantage of Windows is that you can move the window
and place it wherever you want; it is like moving a piece of
paper on your actual desktop. Just click the mouse on the Title
bar (the window should not be maximized; if it fits the screen
you will not be able to move it) hold it and drag. To drag an item
you need to click on the Title bar, hold it, then move the mouse.
The whole process is called Drag and Drop. You can also move a
window (if window is not Maximum) by right clicking on Title
bar and selecting Move. By using the mouse you can even change
the size of the window: (not maximized) take the mouse.

Pointer to the border of the window, a double-edged arrow will
appear:

lets you change the height while   is for the Width.  at

the edge of the window lets you change the ratio between Height
and Width.

3. The Scroll Bar

When you exceed the size of the Window, a vertical rectangle -
Scroll bar - appears at your right. The same applies if you went
over the Width limit, an horizontal Scroll box appears. To go
through the text, just Drag the scroll bar until you reach the
location, you can also click on the arrows at the edges of scroll
bar to browse. A Window cannot extend beyond the size of your
screen, therefore the scroll bar is the perfect solution to extend
beyond the boundaries. The size of the scroll bar (rectangle)
indicates the length of the document.

4. Menu Bar

Windows 98 provides a variety of menus you can use to choose
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and perform different tasks. The most frequently used menu in
Window 98 is Start menu, which you have already learned. In
addition to Start menu, there are many windows and programs
that have their own sets of menus and commands.

INTEXT QUESTIONS

5. What are the features of Windows Explorer?

6. What are the steps for permanently deleting a file?

5.8 SHARING FOLDERS AND PRINTERS

You can share your documents (files) and printers attached to your
computer with other people on the network. To use file and print
sharing, you must first choose which of the following two types of
access you want to give to other users:

a. Share-level access control is the default access setting. It lets
you require a password for each shared resource.

b. User-level access control lets you specify who has access to
each shared resources, but it does not require a password.

By default you will be having a Share-level access control. To change
it to User-level access control, follow the steps given below:

i. Click Start, seletct Settings → Control Panel, and then double-
click Network. Click the Access Control tab. The Network dialog
box appears. Click on User-level access control.

ii. In Obtain list of users and groups from, type the name of the
domain or server you want to use, and then click OK. You may
be prompted to supply additional information about the domain
or server you specified.

iii. Restart your computer.

To set up file-sharing and print sharing services, follow the steps
given below:

i. Click Start, select, Settings → Control Panel, and then double-
click Network. Click the Access Control tab. The Network dialog
box appears. Click on File and Print Sharing.
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ii. Select the check box(es) the sharing options you want, click
OK, and then click OK again. A message prompts you to insert
your Windows 98 CD or Setup disk so that File and Print Sharing
can be installed. You must restart your computer before the
new settings will take effect. After you have set up file-sharing
services, you can share a folder or printer.

To share a folder with share-level access control, follow the steps
given below:

i. In My Computer, right-click the folder you want to share, and
then click Sharing in the submenu. Properties dialog box will
appear. Click on the Sharing tab, and then click Shared As.

ii. In Share Name, type a name for the folder. In Comment, you
can type a brief comment or description of the folder.

iii. In Access Type, click Read Only, Full, or Depends on Password.
Regardless of which type of access you select, you have the
option of adding a password.

iv. Type a password if you want to use one, and then click OK.
Retype the password and then click OK. The folder or printer
icon changes to a folder or printer with a hand, indicating that
the item is now shared.

To share a folder with User-level access control, follow the step given
below:

i. Follow the steps i. and ii. Given above.

ii. Click Add. In the Add Users dialog box, click the name(s) of the
person(s) to whom you want to grant permission(s). You can
scroll the list of users, or you can type the name and the list
will scroll automatically. If you want to grant the same
permissions to everyone connected to your network, leave The

World selected.

iii. Click the type of access permissions you want to give to the
selected user(s). Read Only means the user has the ability to
read, but not change, files. Full Access means the user has the
ability to read, delete, and change file. Custom means the user
has a combination of privileges that you specify.

iv. When you are finished adding users permission, click OK.

To share a printer with share-level access control, follow the steps
given below:
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i. In My Computer, double-click the Printers folder. Right-click
the printer you want to share, and then click Sharing. On
Sharing tab, click Shared As.

ii. In-Share Name, type a name for the printer. In Comment, you
can type a brief comment or a description of the printer.

iii. In Password, you can type a password, retype the password to
verify it. Click OK.

iv. Click OK. If you typed a password, retype the password to verify
it. Click OK.

To share a printer with User-level access control, follow the steps
given below:

i. Follow the steps i. And ii. Given above.

ii. Click Add. In the Add Users dialog box, click the name (s) of the
person(s) to thom you want to grant permissions. You can scroll
the list of users, or you can simply type the name and the list
will scroll automatically. If you want to grant the same
permissions to everyone connected to your network, leave The
World selected.

iii. Click Full Access. The name(s) of the persons(s) you have chosen
will be moved to the box on the right side of the screen. When
you are finished adding users and permissions, click OK.

If you have correct permissions, you can use files and printers that
are shared on the other computers. To use a shared folder or printer,
follow the steps given below:

i. Double-click Network Neighborhood

ii. Double-click the icon for the computer that controls the folder
or printer you want to use. If the computer you are looking for
is not in your workgroup or domain, first click Entire Network,

and then double-click the appropriate workgroup or domain.

iii. To use a shared folder or printer, double-click its icon.

5.9 MS-DOS-BASED PROGRAM

You can run MS-DOS-based programs by using the MS-DOS Prompt
command in the Programs menu. Click on Start and then choose
Programs→MS-DOS Prompt. This opens an MS-DOS  command
window in which you can run your MS-DOS-based programs.
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Using MS-DOS Commands: We have given some examples below to
know how to use MS-DOS based commands:

1. Be sure that the MS-DOS window is active.

2. At the MS-DOS prompt (c:/), type DIR and press Enter. The
files and folders stored in your open folder on the hard disk
appear in a list. The DIR command means “directory,” and lists
all files and folders in your current directory (folder).

3. At the next MS-DOS prompt, type “CD \Windows” and then
press ENTER. The folder changes to the Windows folder in the
same drive (if it exists). The CD command means “change
directory”. The backslash (\) and Windows indicates the
directory path for your Windows folder.

The following Table gives a list of MS-DOS commands.

Table 5.1

List of DOS Commands

Command /? list switches for the DOS command
“command”

Path=c:\windows;c:\dos specify in which directories DOS
searches for commands or programs

Prompt $p$g make the DOS prompt display the
current directory

Dir list files in the current directory in one
column

Dir /w list files in five columns

Dir /p list files one page at a time

Dir *.exe list all files with an “EXE” extension

Dir z????.exe list “EXE” files that have five letters and
start with z

Dir winsock.dll/s searches for the file “winsock.dll” in the
current directory

Type file.ext view the contents of the text file
“file.ext”

Edit file.ext use the DOS 5 editor to edit the file
“file.ext”
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A: change to the A: drive

Md c:\myfiles make a new subdirectory named
“myfiles”

Cd c:\myfiles change to subdirectory “myfiles”

Rd c:\myfiles remove the existing subdirectory
named “myfiles”

Del file.ext delete a file named “file.ext”

Ren f1 f2 rename file “f1” to “f2”

Copy f1 f2 copy file “f1” to “f2”

Verify on turn on verification of copy commands

Verify off turn off verification of copy commands

Xcopy d1 d2 /s copy all files and subdirectories in
directory “d1”

Xcopy d1 d2 /p ask for confirmation of each file before
copying

Diskcopy a: b: duplicate a disk using two floppy drives

Diskcopy a: a: duplicate a disk using the same floppy
drive

Format a: format floppy disk in drive a:

Format a: /s: format a bootable floppy disk (include
system)

Backup c:\d1\*.txt a: back up all files with the extension
“.TXT” in “c:\d1\” to the “a:” floppy
drive

Backup c:\ a: /s back up the entire C: drive to floppy
drive a:

Restore a: c:\d1\*.txt restore certain files to C: from A:

Restore a: c:\ /s restore back-up files and
subdirectories

Ver check the version of DOS

Time check or correct the system time

Date check or correct the system date

Cls clear the screen

Scandisk scan and check the disk C: for errors
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Chkdsk check disk and memory usage of the
current disk

Chkdsk /f fix errors reported by chkdsk

Chkdsk filename check a particular file

Chkdsk a: check a particular disk (a floppy in the
a: drive)

Mem check memory usage

Note: Replace the drive letter as needed for your own computer.
Also, you can type these commands in either upper or lower case
letter, because DOS does not distinguish case.

5.10 WHAT YOU HAVE LEARNT

In this lesson you learnt about the need and functions of operating
system. In particular, you learnt the basic features of Windows98.
Windows is a GUI which use pictures, symbols and words on the
computer monitor and can be controlled by a mouse. It handles
internal function of the computer and manages computer memory
input and output operations. Now you will be in a position to operate
the computer.

5.11 TERMINAL QUESTIONS

1. Write the utilities of the following Tools tab options of the
Properties Window in My Computer:

(a) Error-checking status,

(b) Backup status, and Defragementation status.

2. What are the utilities of the following in Windows 98?

(a) My Document

(b) Recycle Bin

(c) Internet Explorer, and

(d) Network Neighborhood

3. Explain briefly the functions of Start button and Taskbar.

4. Explain the steps in creating a folder.

5. Explain the steps in opening a file or folder.
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6. Explain the following

(a) Minimize, Maximize/Restore, and Close

(b) Title Bar

(c) The Scroll Box, and

(d) Menu Bar.

7. Explain the steps in using files and printers controlled by oth-
ers?

8. What is a shortcut. How do you create shortcut.

5.12 KEY TO INTEXT QUESTIONS

1. Creates the link between the user and computer. Handles in-
ternal function such as managing the computer memory. It is a
graphical user interface. The  world wide web is easily acces-
sible from anywhere through Windows. Supports DVD and digi-
tal audio.

2. (a) Moving the mouse to place the pointer on an item is called
pointing.

(b) Pointing to an item on the screen and the quickly pressing
and releasing the left mouse button is called clicking.

(c) Pointing to an item and then quickly pressing and releasing
the mouse button twice is called double clicking.

(d) Pointing to an item and then holding down the mouse button
is called dragging.

3. The Desktop is placing where useful things are accessible by
the user, depending on which options you choose during
installations.

4. My Computer contains

hard drives ‘C’, floppy drive CD ROM drive, printers, control
panel, Dial up Networking and Scheduled task.

5. Instead of opening drives and folders in separate windows, the
user can browse the content in a single Window in a hierarchical
structure.

6. On the desktop double click Recycle Bin. In Recycle Bin select
the file or folder you want to permanently delete. On the toolbar
click delete. The confirm file delete dialog box oppears. Then
click yes, the file is permanently deleted from the computer.


